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Introduction
The tutorials that follow provide a brief introduction to both the user 
interface and the calculation capabilities of Spartan Student. The 
intent is to provide hands-on experience with use of the user interface 
and in doing so, illustrate the set up, submission, and interpretation of 
molecular mechanics and quantum chemical calculations. Tutorials 
are not intended to illustrate the full range of capabilities available 
in Spartan Student, but focus on use of the program to calculate 
equilibrium and transition-state geometries, to search conformation 
space, to align molecules, to evaluate reaction thermochemistry and 
activation energetics and to obtain NMR and infrared spectra.

Operating Spartan (Chapter 2 in the Spartan Student overview) 
outlines the basic workings of Spartan’s graphical user interface. 
It should be reviewed before starting the tutorials and referred to 
as needed. The first and second tutorials (Basic Operations and 
Acrylonitrile: Building an Organic Molecule) cover a number of 
important general features of the program and should be completed 
first and in that order. The next twelve tutorials cover more specialized 
topics and may be completed in any order. The last five tutorials point 
to an entirely different mode of using Spartan Student by drawing 
on the large amount of information from the Spartan Spectra and 
Properties Database (SSPD).

The Basic Operations tutorial requires a file of previously calculated 
results. In addition, other tutorials need access to experimental spectra 
in the event that the computer is not online or that specific spectra 
are not available online. For Windows, these files are located in the 
tutorials directory accessible from ProgramFiles(x86)/Wavefunction/
Spartan Student v5, but for security reasons should be copied to a 
separate location. For Macintosh, this is located in the SpartanStudent 
v5 disc image (CD-ROM and/or .dmg file).
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1
Basic Operations

This tutorial introduces a number of basic operations in Spartan 
Student required for molecule manipulation, property query and 
spectra and graphics display. Specifically it shows how to: i) open 
molecules, ii) view different model styles and manipulate molecules 
on screen, iii) measure bond distances, angles and dihedral angles, 
iv) display energies, dipole moments, atomic charges and infrared 
and NMR spectra, and v) display graphical surfaces and property 
maps. Spreadsheet operations are not illustrated, no molecules are 
built and no quantum chemical calculations are performed.

1.	 Start Spartan. Click (left mouse button) on File from the menu 
bar that appears at the top of Spartan Student’s main window.* 
Click on Open... from the File menu that appears. Alternatively, 
click on the  icon at the top of the screen. A file browser 
appears.

	 Move to the tutorials** directory, click on basic operations and 
click on Open (or double click on basic operations). A single 
file containing ethane, acetic acid dimer, propene, ammonia, 
hydrogen peroxide, acetic acid, water, cyclohexanone, 
camphor, ethylene, benzene, aniline and cyclohexenone 
will be opened. A ball-and-spoke model for the first molecule 
(ethane) will be displayed, and its name appears at the bottom 
right of the screen.

2.	 Practice rotating (move the mouse while holding down the left 
button) and translating (move the mouse while holding down 
the right button). Click on Model from the menu bar.

*	 The right and left buttons on a touchpad may be used in place of the right and left mouse 
buttons.

**	 For Windows, these files are located in the tutorials directory in ProgramFiles(x86)/
Wavefunction/Spartan Student v5 but for security reasons should be copied to a separate 
location. For Macintosh, this is located at the top level on the installation CD-ROM.
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		  Wire	 Ball-and-Wire	 Tube	 Ball-and-Spoke

	 One after another, select Wire, Ball and Wire, Tube and finally 
Ball and Spoke from the Model menu. All four model styles 
for ethane show roughly the same information. The wire model 
looks the most like a conventional line formula. It uses color to 
distinguish different atoms, and one, two and three lines between 
atoms to indicate single, double and triple bonds, respectively.

	 The ball-and-wire model is identical to the wire model, except 
that atom positions are represented by small spheres, making 
it easy to identify atom locations. The tube model is similar 
to the wire model, except that bonds are represented by solid 
cylinders. The tube model is better than the wire model in 
conveying three-dimensional shape. The ball-and-spoke model 
is a variation on the tube model; atom positions are represented 
by colored spheres, making it easier to see atom locations.

	 Select Space Filling from the Model menu.
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	 Space-Filling

	 The space-filling model is different from the other models in 
that bonds are not shown. Rather, each atom is displayed as a 
colored sphere that represents its approximate size. Thus, the 
space-filling model for a molecule provides a measure of its 
size. While lines between atoms are not drawn, the existence 
(or absence) of bonds can be inferred from the extent to 
which spheres on neighboring atoms overlap. If two spheres 
substantially overlap, then the atoms are almost certainly 
bonded, and conversely, if two spheres barely overlap, then 
the atoms are not bonded. Intermediate overlaps suggest weak 
bonding, for example, hydrogen bonding.

3.	 Click once on the right arrow key  at the bottom left of the 
screen. This will move to the next molecule in the document, 
acetic acid dimer. Its name will appear at the bottom of the 
screen. If you make a mistake, use the backward  or forward 

 step keys to locate acetic acid dimer in the document. Switch 
to a space-filling model and look for overlap between the (OH) 
hydrogen on one acetic acid molecule and the (carbonyl) 
oxygen on the other. Return to a ball-and-spoke model and 
select Hydrogen Bonds from the Model menu.

	
	 Ball-and-Spoke model for acetic acid dimer with hydrogen bonds displayed

	 The two hydrogen bonds, that are responsible for holding the 
acetic acid molecules together, will be drawn.
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4.	 Distances, angles, and dihedral angles can easily be measured 
using Measure Distance, Measure Angle, and Measure 
Dihedral, respectively, from the Geometry menu.

	

a)	 Measure Distance: This measures the distance between 
two atoms. Click once on  to move to the next molecule, 
propene, and then select Measure Distance from the 
Geometry menu (or click on the  icon at the top of the 
screen). Click on a bond or on two atoms (the atoms do not 
need to be bonded). The distance (in Ångstroms) will be 
displayed at the bottom of the screen. Repeat the process for 
several atoms. When you are finished, select View from the 
Build menu (or click on the  icon at the top of the screen).

  

b)	 Measure Angle: This measures the angle around a central 
atom. Click once on  to move to the next molecule, 
ammonia, and then select Measure Angle from the 
Geometry menu (or click on the  icon at the top of the 
screen). Click first on H, then on N, then on another H. 
Alternatively, click on two NH bonds. The HNH angle (in 
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degrees) will be displayed at the bottom of the screen. Click 
on  when you are finished.

c)	 Measure Dihedral: This measures the angle formed by 
two intersecting planes, one containing the first three 
atoms selected and the other containing the last three atoms 
selected. Click once on  to move to the next molecule, 
hydrogen peroxide, then select Measure Dihedral from 
the Geometry menu (or click on the  icon at the top of 
the screen) and then click in turn on the four atoms (HOOH) 
that make up hydrogen peroxide. The HOOH dihedral 
angle will be displayed at the bottom of the screen. Click 
on  when you are finished.

5.	 Energies, dipole moments and atomic charges among other 
calculated properties, are available from Properties under the 
Display menu.

	

a)	 Energy: Click once on  to move to the next molecule,  acetic 
acid, and then select Properties from the Display menu. 
The Molecule Properties dialog appears. It is divided into 
two parts designated by tabs. Molecule provides the energy 
and other information relating to the isolated molecule, 
Thermodynamics provides the enthalpy, entropy, heat 
capacity, Gibbs energy and zero-point energy.  Make certain 
that the Molecule tab is selected. 
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	 This provides the energy for acetic acid in atomic units 

(Energy in au). Also provided is an estimate of the energy in 
water (Energy(aq) in au) and the difference between the two 
(Solvation E kJ/mol).

b)	 Dipole Moment: The magnitude of the dipole moment 
(Dipole Moment in debyes) is also provided in the Molecule 
Properties dialog. A large dipole moment indicates large 
separation of charge. You can attach the dipole moment 
vector,  where the + side refers to the positive end of the 
dipole, to the model on the screen, by checking the box to the 
left of  Display Dipole Vector near the bottom of the dialog.

c)	 Atomic Charges: To display the charge on an atom, click on it 
with the Molecule Properties dialog on the screen. The Atom 
Properties dialog replaces the Molecule Properties dialog.
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	 Electrostatic atomic charges are given in units of electrons. 
A positive charge indicates a deficiency of electrons on an 
atom and a negative charge, an excess of electrons. Repeat 
for other atoms. Confirm that the positively-charged atom(s) 
lie at the positive end of the dipole moment vector. When 
you are finished, close the dialog by clicking on .

d)	 Infrared Spectra: Molecules vibrate (stretch, bend, twist) 
even if they are cooled to absolute zero. This is the basis 
of infrared spectroscopy, where absorption of energy occurs 
when the frequency of a particular molecular motion matches 
the frequency of the light. Infrared spectroscopy is important 
for identifying molecules as different functional groups 
vibrate at noticeably different and characteristic frequencies. 

	 Click once on  to move to the next molecule in the 
document, water. To animate a vibration, select Spectra 
from the Display menu and click on the IR tab. This leads 
to the IR Spectra dialog.

	
	 This displays the three vibrational frequencies for the water 

molecule, corresponding to bending and symmetric and 
asymmetric stretching motions. One after the other, click in 
the box to the left of each frequency and examine the motion. 
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(To vary the animation speed, select Preferences from the 
Options menu, click on the Settings tab and move the slider 
bar below Animation Speed.) Turn off the animation by 
clicking in the box of the selected frequency when you are 
finished.

	 Click once on  to move to cyclohexanone, the next 
molecule in the list. The Spectra dialog now lists 45 
frequencies corresponding to the 45 vibrational motions of 
this molecule with 17 atoms. Examine each in turn (click 
on the entry in the dialog) until you locate the frequency 
corresponding to the carbonyl stretch. Next, click on Draw 
Calculated at the top of the dialog. The infrared spectrum 
of cyclohexanone appears at the bottom of the screen. Note 
that the line corresponding to the carbonyl stretch is isolated 
and that it is very intense, making it easy to find.

	
	 If your computer is connected to the internet, you can draw 

the experimental IR spectrum for cyclohexanone on top of the 
calculated spectrum. Select Web Site under Experimental 
Data From: at the bottom of the Spectra dialog. Click on 
Draw Experimental.
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	 If you are not online or have trouble downloading the experimental 
spectrum, select Local File under Experimental Data From: and 
find cyclohexanoneIR.dx in the tutorials directory.  

	 The two spectra are broadly similar. To bring the calculated 
spectrum into even closer agreement with the experimental 
spectrum, click on the Experimental button under Standard 
Fit at the center of the IR Spectra dialog.

	
	 You can remove the plot by clicking on both Delete 

Calculated and Delete Experimental in the Spectra dialog. 
(These buttons have replaced Draw Calculated and Draw 
Experimental, respectively.)

e)	 NMR Spectra: Along with mass spectrometry, NMR 
spectroscopy is the most powerful tool available with which 
to assign molecular structure. Many nuclei exhibit NMR 
spectra, but proton and 13C are by far the most important.

	 Click once on  to move to the next molecule in the 
document, camphor. With the Spectra dialog on screen, 
click on the 13C NMR tab to bring up the 13C NMR Spectra 
dialog.
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	 Click on Draw Calculated under 13C Spectrum to show the 

calculated 13C spectrum.

	
	 There are nine lines, in the range of 200 to 0 ppm (the tenth 

line corresponding to the carbonyl carbon is at 218 ppm). 

	 To magnify a region of the spectra, position the cursor at one 
corner of the region, drag the mouse to the opposite corner 
while holding down the left button, then release the button. 
Magnifying in the region from 0 to 60 ppm yields the plot.

	
	 Select Local File under Experimental Data From: at the 

bottom right of the dialog and find camphor.NMR.dx in 
the tutorials directory and click on Draw Experimental to 
draw the experimental spectrum. 
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	 Remove the spectra by clicking on Delete Calculated and 
Delete Experimental in the 13C NMR Spectra dialog. 
(These buttons have replaced Draw Calculated and Draw 
Experimental, respectively.) 

	 To obtain numerical values for the individual chemical 
shifts, select Properties from the Display menu (to bring 
up the Atom Properties dialog) and click on the atom of 
interest. Note that proton shifts in addition to 13C shifts are 
available. 

6.	 Spartan Student permits display, manipulation and query 
of a number of important graphical quantities resulting from 
quantum chemical calculations. Most important are the electron 
density (that reveals how much space a molecule actually takes 
up), the bond density (that reveals chemical bonds), and key 
molecular orbitals (that provide insight into both bonding and 
chemical reactivity). In addition, the electrostatic potential 
map, an overlay of the electrostatic potential (the attraction or 
repulsion of a positive charge for a molecule) on the electron 
density, is valuable for describing overall molecular charge 
distribution as well as anticipating sites of electrophilic addition. 
Another indicator of electrophilic addition is provided by the 
local ionization potential map, an overlay of the energy of 
electron removal (ionization) on the electron density. Finally, 
an indicator of nucleophilic addition is provided by the |LUMO| 
map, an overlay of the absolute value of the lowest-unoccupied 
molecular orbital (the LUMO) on the electron density.

	 Click once on  to move to the next molecule in the list, 
ethylene. Select Orbital Energies from the Display menu 
(or click on ). An orbital energy diagram for ethylene will 
appear at the left of the screen. This provides the energies of all 
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six occupied valence molecular orbitals and two lowest-energy 
unoccupied molecular orbitals.

	

	 Click on the energy level in the diagram labelled HOMO. In a 
second, the familiar π bond in ethylene will appear. 

	

	 Note that the graphic is made up of separate blue and red 
surfaces. These correspond to positive and negative values of 
the orbital (the absolute sign is arbitrary). Examine the other 
occupied orbitals (by clicking on their respective energy levels 
in the diagram) as well as the lowest-unoccuped molecular 
orbital (the LUMO).

	 Click once on  to move to the next molecule in the list, benzene. 
Select Surfaces from the Display menu. The Surfaces dialog 
appears.
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 	 Select Electrostatic Potential Map inside the Surfaces dialog 
(click inside the box to the left of the name). An electrostatic 
potential map for benzene will appear.*

	

	 Click on the map. The Style menu will appear at the bottom 
right of the screen. Select Transparent from this menu. This 
makes the map transparent and allows you to see the molecular 
skeleton underneath. Go back to a Solid display (Style menu) in 
order to clearly see color differences. The surface is colored red 
in the π system (by convention, indicating negative potential 
and the fact that this region is attracted to a positive charge), 
and blue in the σ system (by convention, indicating positive 
potential and the fact that this region is repelled by a positive 
charge). Bring up the Properties dialog (Display menu) and 
click on the map. Remove the checkmark from the box to the left 
of Bands in the Surface Properties dialog to replace the series 
of color bands (discrete display) by a continuous display.**

*	 The graphics shown in this document have been obtained at high resolution. In order to 
reduce its size, the file associated with this tutorial provides medium-resolution images.

**	 Discrete displays are the default in Spartan Student. You can change the default to continuous 
displays from the Molecule Preferences dialog (Preferences under the Options menu; 
Chapter 10).
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	 Click once on  to move to the next molecule in the list, aniline, 
and select Local Ionization Potential Map inside the Surfaces 
dialog. By convention, red regions on a local ionization potential 
map indicate areas from which electron removal (ionization) is 
relatively easy, meaning that they are subject to electrophilic 
attack. These are easily distinguished from regions where 
ionization is relatively difficult (by convention, colored blue). 
Note that the ortho and para ring carbons are more red than the 
meta carbons, consistent with the known directing ability of the 
amino substituent.

	

	 Click once on  to move to the next molecule in the list, 
cyclohexenone, and select LUMO inside the Surfaces dialog. 
The resulting graphic portrays the lowest-energy empty 
molecular orbital (the LUMO) of cyclohexenone. This orbital 
is delocalized onto several atoms and it is difficult to tell 
where exactly a pair of electrons (a nucleophile) will attack the 
molecule.
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	 A clearer portrayal is provided by a LUMO map, that displays the 
(absolute) value of the LUMO on the electron density surface. 
By convention, the color blue is used to represent maximum 
value of the LUMO and the color red, minimum value. First, 
remove the LUMO from your structure (select LUMO in the 
Surfaces dialog) and then turn on the LUMO map (select 
|LUMO|Map in the dialog).

	
	 Note that there are two blue regions, one directly over the 

carbonyl carbon and the other over the β carbon. This is entirely 
consistent with known chemistry. Enones may either undergo 
carbonyl addition or conjugate (Michael) addition.

	

HO CH3

CH3

OO

CH3Li
carbonyl addition

(CH3)2CuLi
Michael addition

7.	 When you are finished, close the document by selecting Close 
from the File menu or alternatively by clicking on the  icon 
at the top of the screen.
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2
Acrylonitrile: Building an 

Organic Molecule
This tutorial illustrates use of the organic model kit, as well as the 
steps involved in examining and querying different molecular model 
styles and in carrying out a quantum chemical calculation.

The simplest building blocks incorporated into Spartan Student’s 
organic model kit are atomic fragments. These constitute specification 
of atom type, for example, carbon, and local environment, for example, 
tetrahedral. However, much of organic chemistry is organized around 
functional groups, collections of atoms, the structure and properties of 
which are roughly the same in every molecule. The organic model kit 
also incorporates a small library of functional groups that can easily 
be extended or modified. For example, the carboxylic acid group may 
be modified to build a carboxylate anion (by deleting a free valence 
from oxygen), or an ester (by adding tetrahedral carbon to the free 
valence at oxygen).

R
C

O
H

C

carboxylic acid
R

C
O–

O

carboxylate anion
R

C
O

CH3

O

ester

Acrylonitrile provides a good opportunity to illustrate the basics of 
molecule building in Spartan Student, as well as the steps involved 
in carrying out and analyzing a quantum chemical calculation.

C C
H

H H

C
N

1.	 Click on File from the menu bar. Then click on New from the 
menu that appears (or click on the  icon at the top of the 
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screen). The organic model kit appears.

	
	 At the center of the kit is a library of atomic fragments. Click 

on trigonal planar sp2 hybridized carbon  from the fragment 
library. A model of the fragment appears at the top of the model 
kit. Bring the cursor anywhere on screen and click. Rotate the 
carbon fragment (drag the mouse while holding down the left 
button) so that you can clearly see both the double free valence 
(=) and the two single free valences (–).

Spartan Student’s model kits connect atomic fragments (as well as 
groups, rings and ligands) through free valences. Any free valences 
that remain upon exiting a model kit are automatically converted 
to hydrogen atoms.

2.	 sp2 carbon is still selected. Click on the double free valence. The 
two fragments are connected by a double bond, leaving you with 
ethylene. The name ethylene will appear at the bottom right of 
the screen.* If you make a mistake and click instead on the single 
free valence, select Undo from the Edit menu. You can also start 
over by selecting Clear from the Edit menu.

*	 This means that ethylene is in the subset of the SSPD database included with Spartan 
Student.
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Spartan Student’s organic model kit allows only the same type of 
free valences to be connected, for example, single to single, double 
to double, etc.

3.	 Click on Groups in the model kit, and select Cyano from the 
functional groups available from the menu.

	
	 Click on any of the four single free valences on ethylene (they 

are equivalent). This bonds the cyano group to ethylene, leaving 
you with acrylonitrile.* Its name will now appear at the bottom 
right of the screen.

4.	 Select Minimize from the Build menu (or click on the  icon 
at the top of the screen). The final molecular mechanics energy 
(36.2 kJ/mol) and symmetry point group (Cs) are provided at the 
bottom right of the screen.

5.	 Select View from the Build menu (or click on the  icon at 
the top of the screen). The model kit disappears, leaving only a 
ball-and-spoke model of acrylonitrile on screen.

*	 You could also have built acrylonitrile without using the Groups menu. Starting from scratch 
(Clear from the Edit menu), first build ethylene as above, then select sp hybridized carbon 

 from the model kit and then click on one of the free valences on ethylene. Next, select 
sp hybridized nitrogen  from the model kit and click on the triple free valence on the 
sp carbon. Alternatively, you could have built the molecule entirely from groups. Starting 
from scratch, click on Groups, select Alkenyl from the menu and click anywhere on screen. 
Then select Cyano from the menu of functional groups and click on one of the free valences 
on ethylene. In general, molecules can be constructed in more than one way.



Tutorial 2	 19

	
	 ball-and-spoke model

	 This model can be rotated, translated and zoomed by using the 
mouse in conjunction with keyboard functions. To rotate the 
model, drag the mouse while holding down the left button; to 
rotate in the plane of the screen also hold down the Shift key. 
To translate the model, drag the mouse with the right button 
depressed. To zoom the model (translation perpendicular to the 
screen), use the center mouse wheel (scroll wheel) if available, 
or hold down the Shift key in addition to the right button while 
dragging the mouse up (zoom in) or down (zoom out).* 

6.	 Select Configure... from the Model menu, and click to select 
Mass Number under Atom in the Configure dialog that appears.

	
	 Click on OK to remove the dialog. Mass numbers will appear 

next to the individual atoms. Remove the atom labels by clicking 
to deselect Labels from the Model menu.**

*	 For touchpads, the thumb-finger touch/open gesture also zooms in and pinching zooms out.
**	 Labels from the Model menu is automatically selected (turned on) following a change in 

the Configure dialog by choosing OK or Apply.
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7.	 Select Calculations... from the Setup menu, and perform the 
following operations in the resulting Calculations dialog.

	

	 Select Equilibrium Geometry from the leftmost menu to the 
right of Calculate. This specifies optimization of equilibrium 
geometry. Select EDF2 and then 6-31G* from the middle and 
right menus to the right of Calculate. This specifies an EDF2 
density functional calculation using the 6-31G* basis set. This 
method generally provides a reliable account of geometries. 
When you finish, click on OK to remove the dialog.

8.	 Select Submit from the Setup menu.* A file browser appears.

	

	 The name acrylonitrile will be presented to you in the box to 
the right of File name. Either use it or type in whatever name 

*	 You could also have clicked on Submit inside the Calculations dialog.
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you like and then click on Save.* You will be notified that the 
calculation has been submitted.

	
	 Click on OK to remove the message from the screen.

You are not permitted to modify any dialogs or other information 
associated with a molecule that has been submitted until the 
calculation has completed.

9.	 You will be notified when the calculation has completed.

	
	 Click on OK to remove the message from the screen. Select 

Output from the Display menu. A window containing text output 
for the job appears.

	
*	 Proper names will automatically be provided for you to accept, modify or replace whenever 

the molecule exists in the subset of the SSPD database supplied with Spartan Student, and 
where the document being submitted contains only one molecule. Otherwise the names 
spartan1, spartan2, etc., will be provided.
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	 You can scan the output from the calculation by using the scroll bar 
at the right of the window or by clicking (left button) on or inside 
the output window and using the scroll wheel on your mouse. The 
information at the top of the dialog includes the task, basis set, 
number of electrons, charge and multiplicity, as well as further 
details of the calculation. Below this is the symmetry point group 
of the molecule that was maintained during the optimization.

	 Eventually, a series of lines appear, under the heading Optimization. 
These tell the history of the optimization process. Each line (or 
Step) provides results for a particular geometry. Ideally, the energy 
will monotonically approach a minimum value for an optimized 
geometry. If the geometry was not optimized satisfactorily an 
error message, such as: Optimization has exceeded N steps – 
Stop, will be displayed following the last optimization cycle. 
If this were the case, you would have been notified that the job 
had failed, rather than seeing the completed message dialog.

	 Near the end of the output is the final energy (-170.69883 atomic 
units for acrylonitrile from the EDF2/6-31G* density functional 
model), and the computation time. Click on  at the top of the 
output dialog to close it.

Energy: By convention, Hartree-Fock density functional theory 
and Møller-Plesset models provide energy results in terms of total 
energy. This is the energy of a reaction that splits a molecule into 
isolated nuclei and electrons, for example, for acrylonitrile.

H2C=CHCN → 3C6+ + N7+ + 3H+ + 28e–

Total energies, as the energies of such reactions are termed, are 
always negative and may be very large (tens of thousands of kJ/
mol). They are most commonly given in atomic units (hartrees).

1 atomic unit = 2625 kJ/mol
Heat of Formation: Experimental thermochemical data are 
normally given as heats of formation which corresponds to the 
enthalpy at 298K of a chemical reaction in which a molecule is 
converted to a set of standard products. For example, the heat of 
formation of acrylonitrile is given by reaction,
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H2C=CHCN → 3C(graphite) + 1/2N2(gas) + 3/2H2(gas)

Where graphite, nitrogen molecule and hydrogen molecule are the 
carbon, nitrogen and hydrogen standards, respectively. Heats of 
formation may either be positive or negative quantities and generally 
span a range of only a few hundred kJ/mol.

To summarize, the heat of formation differs from the total energy 
both with regard to the standard reaction with reagard to units. Either 
provides a suitable basis for thermochemical calculations.

	 You may examine the total energy and dipole moment among 
other calculated properties without having to go through the 
output. Select Properties from the Display menu to bring up 
the Molecule Properties dialog.

	  
	 To see the dipole moment vector (indicating the sign and 

direction of the dipole moment), check the box to the right of 
Display Dipole Vector. (wire, ball-and-wire or tube models are 
best for this display.)

	
	 Uncheck the box to remove the dipole moment vector.
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	 Click on an atom. The (Molecule Properties) dialog will be 
replaced by the Atom Properties dialog.

	  

	 Among other things, this provides atomic charges. To obtain 
the charge on another atom, simply click on it. Inspect all the 
atomic charges on acrylonitrile (by clicking on the appropriate 
atoms). When you are finished, click on  at the top of the 
Atom Properties dialog to close it.

10.	 Select Surfaces from either the Setup or Display menu. Click 
on Add (at the bottom of the Surfaces dialog that results) and 
select Electrostatic Potential Map from the menu.

11.	 The graphics calculation will run without needing to submit the 
job following your request. When it has completed, check the 
box to the left of Electrostatic Potential Map in the Surfaces 
dialog. The surface itself corresponds to the electron density and 
provides a measure of the overall size and shape of acrylonitrile. 
The colors indicate values of the electrostatic potential on this 
surface; by convention, colors toward red correspond to negative 
potential (stabilizing interaction between the molecule and a 
positive charge), while colors toward blue correspond to positive 
potential. The nitrogen (the most electronegative atom) is red and 
the hydrogens (the most electropositive atoms) are blue.

12.	 Select Close from the File menu (or click on ) to remove 
acrylonitrile from the screen.* Also, close any open dialogs.

*	 While Spartan Student permits as many molecules as desired on screen at a given time, it 
will be less confusing for first-time users to keep only a single molecule open at a time.
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3
Sulfur Tetrafluoride: Building 

an Inorganic Molecule
This tutorial illustrates the use of the inorganic model kit for 
molecule building. It also shows how molecular models may be used 
to quantify concepts from more qualitative treatments.

Organic molecules are made up of a relatively few elements and 
generally obey conventional valence rules. They may be easily built 
using the organic model kit. However, many molecules incorporate 
other elements, or do not conform to normal valence rules, or involve 
ligands. They cannot be constructed using the organic model kit. 
Sulfur tetrafluoride is a good example.

F

S

F

F

F

sulfur tetrafluoride

The unusual see-saw geometry observed for the molecule is best 
thought of as the least crowded way to position five electron pairs 
(four bonds and a non-bonded electron pair) around sulfur starting 
from a trigonal bipyramidal arrangement. Because a lone pair is 
bigger than a bonding electron pair, it occupies an equatorial position. 
Sulfur tetrafluoride provides the opportunity to look at the bonding and 
charges in a molecule which appears to have an excess of electrons 
around its central atom (ten instead of eight). 

1.	 Bring up the inorganic model kit by clicking on  and then 
clicking on the Inorganic tab at the top of the model kit.



26	 Tutorial 3

	
	 The inorganic model kit comprises an atom bar (clicking on 

which bring up the Periodic Table*) followed by a selection of 
atomic hybrids, then bond types, and finally Rings, Groups, 
Ligands, More and Clipboard menus (all except for Ligands 
are the same as found in the organic model kit).

2.	 Click on the atom bar to bring up the Periodic Table.

	

	 Select (click on) S in the Periodic Table and the five coordinate 
trigonal bipyramid structure  from the list of atomic hybrids. 

*	 Not all methods are available for all elements. Elements for which a specific method are 
available will be highlighted following selection of a theoretical model from the Model 
menu that appears in the center of the Periodic Table.
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Trigonal bipyramid sulfur will appear at the top of the model 
kit. Click on screen. 

3.	 Again, click on the atom bar, select F in the Periodic Table and 
the one-coordinate entry  from the list of atomic hybrids. 
One after the other, click on both axial free valences of sulfur, 
and two of the three equatorial free valences.

4.	 It is necessary to delete the remaining free valence (on an equatorial 
position); otherwise it will become a hydrogen. Click on  and 
then click on the remaining equatorial free valence.

5.	 Click on . Click on  to remove the model kit.

6.	 Select Calculations... from the Setup menu. Specify calculation 
of Equilibrium Geometry* using the EDF2 6-31G* model and 
click on Submit. Supply the name sulfur tetrafluoride see-saw.

7.	 After the calculations have completed, select Properties from 
the Display menu to bring up the Molecule Properties dialog. 
Next, click on sulfur to bring up the Atom Properties dialog. Is 
sulfur neutral or negatively charged, indicating that more than 
the normal complement of (eight) valence electrons surround 
this atom, or is it positively charged, indicating ionic bonding?

	

F

S

F

F

F

8.	 Select Orbital Energies from the Display menu (or click on 
). An orbital energy diagram for sulfur tetrafluoride will 

appear at the left of the screen. This will contain the ten highest-
energy occupied molecular orbitals and the two lowest-energy 
unoccupied molecular orbitals.

*	 It should be noted that were an incorrect geometry specified at the outset, optimization would 
lead to the correct structure, as long as the starting geometry possessed no symmetry (C1 
point group). Thus, square planar SF4 in D4h symmetry would remain square planar, while an 
almost square planar structure (distorted only slightly from D4h symmetry to C1 symmetry) 
would collapse to the proper structure.
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	 Click on the energy level in the diagram labelled HOMO to 

display the highest-occupied molecular orbital. Does it point 
in the expected direction? It is largely localized on sulfur or is 
there significant concentration on the fluorines? If the latter, is 
the orbital bonding or antibonding?

9.	 Build square planar SF4 as an alternative to the see-saw structure. 
Bring up the inorganic model kit ( ), select S from the Periodic 
Table and the four-coordinate square-planar structure   from 
the list of atomic hybrids. Click anywhere on screen. Select F in 
the Periodic Table and the one-coordinate entry  from the 
list of atomic hybrids. Click on all four free valences on sulfur. 
Click on  and then on .

10.	 Enter the Calculations dialog (Setup menu) and specify 
calculation of equilibrium geometry using the EDF2/6-31G* 
model (the same level of calculation as you used for the see-saw 
structure*). Click on Submit at the bottom of the dialog, with 
the name sulfur tetrafluoride square planar.

11.	 After the calculation has completed, bring up the Molecule 

*	 You need to use exactly the same theoretical model in order to compare energies or other 
properties for different molecules.
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Properties dialog (Properties from the Display menu) and note 
the energy. Is it actually higher (more positive) than that for the 
see-saw structure?

12.	 Close both molecules as well as any remaining dialogs.
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4
Infrared Spectrum of Acetone

This tutorial illustrates the steps required to calculate and display 
the infrared spectrum of a molecule. It also illustrates retrieval of 
the experimental spectrum from an on-line database and fitting the 
calculated spectrum to the experimental spectrum.

Molecules vibrate in response to their absorbing infrared light. 
Absorption occurs only at specific wavelengths, which gives rise to 
the use of infrared spectroscopy as a tool for identifying chemical 
structures. The vibrational frequency is proportional to the square 
root of a quantity called a force constant divided by a quantity called 
the reduced mass. 

frequency
force constant
reduced mass

α

The force constant reflects the flatness or steepness of the energy 
surface in the vicinity of the energy minimum. The steeper the energy 
surface, the larger the force constant and the larger the frequency. 
The reduced mass reflects the masses of the atoms involved in the 
vibration. The smaller the reduced mass, the larger the frequency.

This tutorial shows you how to calculate and display the infrared 
spectrum of acetone, and explore relationships between frequency 
and both force constant and reduced mass. It shows why the carbonyl 
stretching frequency is of particular value in infrared spectroscopy.

1.	 Click on  to bring up the organic model kit. Select sp2 carbon 
( ) and click anywhere on screen. Select sp2 oxygen ( ) and 
click on the double free valence on carbon to make the carbonyl 
group. Select sp3 carbon ( ) and, one after the other, click on the 
two single free valences on carbon. Click on  and then on .

2.	 Enter the Calculations dialog (from the Setup menu). 
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Select Equilibrium Geometry from the left-hand menu 
to the right of Calculate and EDF2 and 6-31G* from the  
two right-hand menus. Check Infrared Spectra in the center 
of the dialog. You have requested that an infrared spectrum be 
computed following optimization of geometry. Click on Submit 
and accept the name acetone supplied to you. This calculation 
will require several minutes of computer time.

3.	 Select Spectra from the Display menu. Click on the IR tab in 
the dialog that results to bring up the IR Spectra dialog.

	

	 This contains a list of vibrational frequencies for acetone. First 
click on the top entry (the smallest frequency) and, when you 
are done examining the vibrational motion, click on the bottom 
entry (the largest frequency).

The smallest frequency is associated with torsional motion of the 
methyl rotors. The largest frequency is associated with stretching 
motion of CH bonds. Methyl torsion is characterized by a flat 
potential energy surface (small force constant), while CH stretching 
is characterized by a steep potential energy surface (large force 
constant).
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	 Locate the frequency corresponding to the CO stretch. The 
experimental frequency is around 1740 cm-1.

The CO stretching frequency is a good chemical identifier because 
it stands alone in the infrared spectrum and because it is intense.

4.	 Click on Draw Calculated to display the calculated infrared 
spectrum.

	

	 If you are on-line, click on Draw Experimental to also bring 
up the experimental spectrum (superimposed on top of the 
calculated spectrum).

	

	 You will note that the two are qualitatively similar, but are shifted 
relative to each other. To provide a best fit, click on Experimental 
below Fit at the top right of the IR tab in the Spectra dialog.
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	 Note that the calculated spectrum now closely matches the 
experimental spectrum. When you are done, click on Delete 
Calculated (which has replaced Draw Calculated) and Delete 
Experimental (which has replaced Draw Experimental) inside 
the IR Spectra dialog to remove the two spectra.

5.	 Change all the hydrogens in acetone to deuteriums to see the 
effect which increased mass has on vibrational frequencies. First 
make a copy of acetone (Save As...  from the File menu or click 
on the  icon at the top of the screen). Name the copy acetone 
d6 Select Properties from the Display menu and click on one 
of the hydrogens. Select 2 deuterium from the Mass Number 
menu. Repeat for the remaining five hydrogens.

6.	 Submit for calculation. This calculation will require only a few 
seconds as results for the difficult part (force constants) are already 
available. When completed, examine the vibrational frequencies. 
Note that the frequencies of those motions which involve the 
hydrogens (in particular, the six vibrational motions corresponding 
to CH stretching) are significantly reduced over those in the non-
deuterated system.

7.	 Close all molecules on screen in addition to any remaining 
dialogs. 
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5
Benzene Chromium 

Tricarbonyl
This tutorial illustrates calculation of the geometry of a simple 
organometallic compound. It also shows how an electrostatic 
potential map may be employed to assess the effect of chromium 
tricarbonyl on the charge distribution at benzene.

Organic chemists know that an amino group attached to benzene adds 
electrons to the ring and leads to an increase in electrophilic reactivity, 
whereas a nitro group has the opposite effect. They probably know less 
about the effects of complexed substituents, for example, the effect 
of chromium tricarbonyl complexed to one face of benzene. In this 
tutorial, you will compare electrostatic potential maps for benzene, 
aniline, nitrobenzene and benzene chromium tricarbonyl in order 
to classify the substituent effect of the Cr(CO)3 group and to rank it 
alongside of NH2 and NO2 groups.

Cr
OC CO

CO

benzene chromium tricarbonyl

1.	 Build benzene chromium tricarbonyl. Click on  and bring 
up the inorganic model kit. Click on the atom bar and select Cr 
from the Periodic Table. Select four-coordinate tetrahedral  
from the list of atomic hybrids. Click anywhere on screen.

2.	 Click on Ligands in the model kit, select Benzene from the 
menu and click on one of the free valences on chromium.
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3.	 Select Carbon Monoxide from the Ligands menu, and click on 
the remaining (three) free valences on chromium. Click on  
to produce a refined structure.

4.	 Select New Molecule (not New) from the File menu. The screen 
will blank. Build benzene (switch to the organic model kit and 
choose Benzene from the Rings menu). Click on . Again, 
select New Molecule from the File menu and build aniline 
(Benzene from the Rings menu and  from the fragment 
panel) and click on . Select New Molecule one last time and 
build nitrobenzene (Benzene from the Rings menu and Nitro 
from the Groups menu) and click on . Click on . The 
document now contains four molecules, benzene chromium 
tricarbonyl, benzene, aniline and nitrobenzene.

5.	 Select Calculations... (Setup menu). Specify calculation of 
Equilibrium Geometry with the Semi-Empirical PM3 model. 
Make certain that Global Calculations (at the bottom of the 
dialog) is checked. You want the calculations to apply to all four 
molecules. Click on OK.

6.	 Select Surfaces (Setup or Display menu). Click on Add and 
select Electrostatic Potential Map from the menu.

7.	 Submit the job. Name it benzene chromium tricarbonyl. When 
completed bring up the spreadsheet (Spreadsheet from the 
Display menu), and check the box to the left of the label for all 
four entries. This allows them to be displayed simultaneously 
on screen. If Coupled (Model menu) is checked, remove 
the checkmark by selecting it. The molecules may now be 
moved independently. Orient each molecule so that you can 
clearly see the benzene face (exposed face in the case of the 
organometallic).
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8. 	 Select Electrostatic Potential Map from the Surfaces dialog. In 
order to better visualize and interpret the electrostatic potential 
map, select Properties from the Display menu and click on one 
of the surface maps to display the Surface Properties dialog.

	

	 Adjust the property range to -150 kJ/mol to 150 kJ/mol, and make 
sure the Global Surfaces box is selected. Compare electrostatic 
potential maps for both free and complexed benzene, with 
attention to the exposed benzene face.* 

	
	 Does the Cr(CO)3 group donate or withdraw electrons from the 

ring? Would you expect the aromatic ring in benzene chromium 
tricarbonyl to be more or less susceptible to electrophilic attack 
than free benzene? More or less susceptible to nucleophilic 
attack? If the Cr(CO)3 is an electron donor, how does it rank 
relative to an amino group? If it is an electron acceptor, how 
does it rank relative to a nitro group?

9 optional

9.	 Repeat the calculations using a more sophisticated theoretical 
model, specifically the EDF2/6-31G* density functional model. 

*	 Electrostatic potential maps (as well as other maps) for molecules in a group will be put onto 
the same (color) scale. This allows comparisons to be made among different members.
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Make a copy of benzene chromium tricarbonyl ( ); name it 
benzene chromium tricarbonyl density functional. Inside the 
Calculations dialog, specify an Energy calculation using the 
EDF2 model with the 6-31G* basis set. You have requested 
that the PM3 geometries obtained in the previous step be used. 
Submit. This will require significantly more computer time 
than the PM3 calculation, although not as much time as would 
be required were you not to use the PM3 geometries. When 
completed, examine the electrostatic potential maps. Are they 
qualitatively similar to those from the PM3 calculations?

10.	 Remove all molecules and dialogs from the screen.
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6
Proton NMR Spectrum of 

2-Norbornene
This tutorial illustrates the calculation of the proton NMR spectrum 
for a simple organic molecule. Chemical shifts are directly evaluated 
but coupling constants are obtained from an empirical relationship.

Proton NMR spectroscopy was the first tool available to chemists to 
allow definitive assignment of the molecular structures of complex 
organic molecules. While it has been supplanted to some extent 
by 13C NMR spectroscopy and more recently by routine X-ray 
crystallography, it remains indispensible. 

NMR is based on the fact that nuclei possess spins that can either 
align parallel or antiparallel to an applied magnetic field, giving rise 
to different nuclear spin states. The relative energy of these states 
(ΔE) depends on the nucleus and on the strength of the applied 
magnetic field, by way of a simple relationship:

∆E = γh/2πB0

γ is the gyromagnetic ratio (a constant for a given type of nucleus), 
h/2π is Planck’s constant divided by 2π and B0 is the strength of the 
magnetic field at the nucleus. While the two nuclear spin states are 
normally in equilibrium, this equilibrium can be upset by applying a 
second magnetic field. The absorption of energy as a function of field 
strength (a resonance) between the states can then be detected. 
The key to the utility of the magnetic resonance experiment is that 
the energy at which a nucleus resonates depends on its location in 
the molecule, and is different for each (chemically) distinct nucleus. 
The reason for this is that the applied magnetic field is weakened 
by electrons around the nucleus. Nuclei that are well shielded by 
the electron cloud will feel a lesser magnetic field than those that 
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are poorly shielded, and will show a smaller energy splitting. The 
difference, given relative to a standard, is termed a chemical shift. By 
convention, both proton and 13C chemical shifts (treated later in this 
chapter) are reported relative to tetramethylsilane (TMS) as a standard.

While each unique proton in a molecule gives rise to a single line 
(resonance) in the spectrum, the spins on nearby nuclei add and 
subtract to the external magnetic field. This leads to a splitting of 
lines, the splitting pattern depending on the number of neighboring 
protons and their geometry. Discounting splitting, the intensity of 
the lines is approximately proportional to the number of equivalent 
protons that contribute. For example, the proton NMR spectrum of 
2-norbornene shows six lines, two with unit intensity corresponding 
to the two different protons on the methylene bridge (C7), and four 
with twice the intensity corresponding to protons  at C1 (C4), C2 (C3) 
and the two different protons on C5 (C6).

7

3

216

5
4

In this tutorial, you will calculate the proton NMR spectrum of 
2-norbornene and compare it with that contained in the Spectral 
Database of Organic Compounds (SDBS), freely-accessible on the 
web from the National Institute of Advanced Industrial Science and 
Technology (AIST) in Japan.*

1.	 Build 2-norbornene. Start from cyclohexane (Rings menu), add 
an sp3 carbon ( ) to an axial ring position and bond to ( ) 
to a free valence on the opposite side of the ring.  Make a double 
bond between the appropriate ring carbons ( ). Minimize ( ) 
and click on ( ).

2.	 Enter the Calculations dialog (Calculations from the Setup 
menu), and specify an Energy calculation using the EDF2 model 
with the 6-31G* basis set. Check NMR Spectra to the right of 
Compute. Click on Submit. Accept the name 2-norbornene. 

*	 Web address: http://riodb1.ibase.aist.go.jp/sbds.cgi-bin/cre_index.cgi.
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Calculation will require a few minutes.

You can, if you wish, avoid doing any calculations as results are 
already available in the database. In this case, click on  to the left of 
the molecule name at the bottom of the screen and click on Replace.

3.	 When it has completed, or after you have retrieved results from 
the database, proton shifts can be found in the Atom Properties 
dialog. Select Properties from the Display menu and one after 
the other click on the hydrogens. Propose assignments for the six 
resonances observed in the experimental spectrum: 5.99, 2.84, 
1.61, 1.31, 1.08 and 0.95 ppm.

4.	 Select Spectra from the Display menu and click on the Proton 
NMR tab. The NMR Spectra dialog appears.

	
	 Make certain that Show HH Couplings is checked and click on 

Draw Calculated. The following proton spectrum appears.
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	 Compare the calculated proton spectrum with that in SDBS (see 
below or examine it on-line).

	
5.	 You may have a difficult time seeing that the lines are split 

(in both calculated and observed spectra). This is because the 
splittings are very small relative to differences in the magnitudes 
of the chemical shifts themselves. Spartan Student provides a 
magnifier tool to assist. To magnify a region in the spectrum, 
position the cursor a the top left of this region (in the example 
above, roughly 1.6 ppm), drag the mouse to the lower right of 
the region (in this example, to the axis at 0 ppm) while holding 
down the left button and then release the button.

	
	 Note that you can continue to magnify the “magnified spectra”. 

To get back to the original, click on .
6.	 Close 2-norbornene and any remaining dialogs when you are 

finished.
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7
13C NMR Spectrum of 

Coumarin
This tutorial illustrates calculation of a 13C NMR spectrum, matching 
it to the corresponding experimental spectrum accessed via an on-
line database. It illustrates correction of the calculated spectrum for 
the effect of the local environment.

There are several reasons why NMR spectroscopy, in particular 
13C NMR, is one of the most important analytical techniques for 
characterizing organic molecules. The experiment is straightforward 
and can be carried out rapidly. It requires relatively small samples 
and is non-destructive. The resulting (proton decoupled) spectrum 
is simple, comprising a single line (resonance) for each and every 
unique carbon. However, assigning 13C spectra can be problematic 
and prone to error, in particular, where several carbons in a molecule 
may be in similar environments.

Directly calculated 13C chemical shifts from practical models are not 
likely to be sufficiently accurate to enable definitive assignments to be 
made. Spartan Student enables calculated 13C chemical shifts from 
both B3LYP/6-31G* and EDF2/6-31G* density functional models 
to be corrected for the effects of local chemical environment. In this 
tutorial, you will compare measured 13C chemical shifts for coumarin 
with those obtained from corrected EDF2/6-31G* calculations. 
Coumarin is a good example both because it is simple enough for the 
experimental assignments to be unambiguous, and because several 
of the 13C shifts are close and therefore difficult to assign.

O O
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1.	 Build and minimize coumarin, then click on . The structure 
and 13C spectrum is available in the database attached to Spartan 
Student and no calculations are needed. All you need to do is 
click on  to the left of the name (coumarin) at the bottom of the 
screen and then click on Replace in the dialog which results. 

You can, if you like, perform the required calculations. This will 
give you an idea of how much computer time is actually needed 
to obtain the structure and 13C spectrum for a small molecule. In 
this event, do not replace the structure you built with the one in 
the database. Instead, bring up the Calculations dialog (Setup 
menu) and select Energy from the left-most menu to the right of 
Calculate and EDF2 and 6-31G* from the two right-most menus. 
Check NMR Spectra to the right of Compute. Click on Submit 
and accept the name coumarin. The calculation will require several 
minutes to complete.

2.	 Following retrieval from the database (or completion of the 
calculation), select Spectra from the Display menu and click 
on the 13C NMR tab. The NMR Spectra dialog results.

	
	 The experimental 13C spectrum is available online.* Make certain 

that Web site under Experimental Data From at the bottom 

*	 Skip this and the next two steps if you are not connected to the internet.
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right of the dialog is checked, and click on Draw Experimental 
under 13C Spectrum at the right near the top of the dialog. In a 
few seconds, the experimental spectrum will appear. Then, click 
on Draw Calculated at the top right of the dialog. A second 
spectrum in a different color will be superimposed onto the 
experimental spectrum.

	
	 Click on Delete Calculated and Delete Experimental to delete 

both calcualted and experimental spectra when you are done. 
Remove the NMR Spectra dialog.

3.	 Select Configure from the Model menu to bring up the 
Configure Labels dialog. (If the Labels tab is not selected, 
click on it.) Select Chem Shift and click on OK. Calculated 
chemical shifts are now attached to your model. Simplify the 
display by removing hydrogens (and chemical shifts attached to 
them). Select Hydrogens from the Model menu. (To revert to the 
original model with hydrogens, simply select Hydrogens again.) 
Associate each of the calculated shifts with the corresponding 
experimental shifts (shown below) and compute a signed error.

	

116.7
131.8

124.4 118.8

128.0 143.5
116.6

160.6154.0
O O

4.	 Close coumarin when you are done. 
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8
Weak vs. Strong Acids

This tutorial shows how to use electrostatic potential maps to 
distinguish between weak and strong acids, and quantify subtle 
differences in the strengths of closely-related acids. It also illustrates 
retrieval of information from Spartan Student’s database.

Nitric and sulfuric acids are strong acids, acetic acid is a weak acid, and 
ethanol is a very weak acid. What these compounds have in common 
is their ability to undergo heterolytic bond fracture, leading to a stable 
anion and a proton. What distinguishes a strong acid from a weak acid 
is the stability of the anion. NO3

– and HOSO3
– are very stable anions, 

CH3CO2
– is somewhat less stable and CH3CH2O– is even less so.

One way to reveal differences in acidity is to calculate the energy of 
deprotonation for different acids, for example, for nitric acid.

HONO2 H+  +  NO3
–

This involves calculations on both the neutral acid and on the 
resulting anion (the energy of a proton is zero). Note, however, 
that the calculations refer to the gas phase, whereas acidity 
measurements generally are made in a solvent, typically water. An 
alternative approach, illustrated in this tutorial, involves comparison 
of electrostatic potential maps for different acids, with particular 
focus on the potential in the vicinity of the acidic hydrogen. The 
more positive the potential, the more likely dissociation will occur, 
and the stronger the acid. Because electrostatic potential maps are 
obtained for the neutral acids and not for the anions, the gas phase 
data from the calculations are more likely to relate to aqueous phase 
measurements, at least in a qualitative sense.

1.	 Build nitric acid. Click on  to bring up the organic model 
kit. Select Nitro from the Groups menu and click anywhere 
on screen. Add sp3 oxygen  to the free valence on nitrogen. 
Click on . Build sulfuric acid. Select New Molecule (not 
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New) from the File menu. Select Sulfone from the Groups 
menu and click anywhere on screen. Add sp3 oxygen to both 
free valences on sulfur. Click on . Build acetic acid. Again 
select New Molecule. Select Carboxylic Acid from the Groups 
menu and click anywhere on screen. Add sp3 carbon  to 
the free valence at carbon. Click on . Finally, build ethanol. 
Select New Molecule and construct from two sp3 carbons and 
an sp3 oxygen. Click on , and then on .

2.	 Bring up the Calculations dialog and specify calculation of 
equilibrium geometry using the EDF2/6-31G* model. Click 
on OK. Bring up the Surfaces dialog, click on Add (at the 
bottom of the dialog) and select Electrostatic Potential Map 
from the menu. Leave the Surfaces dialog on screen. Submit 
for calculation with the name acids.

3.	 When completed, bring up the spreadsheet and check the box 
immediately to the left of the molecule label for all four entries. 
The four molecules will now be displayed simultaneously on 
screen. Select (uncheck) Coupled from the Model menu so 
that they may be independently manipulated, and arrange on 
screen such that the acidic hydrogens are visible.

Mouse operations normally refer only to the selected molecule. To 
rotate/translate molecules together, hold down the Ctrl (Control) 
key in addition to the left/right buttons, while moving the mouse.

4.	 Click on Electrostatic Potential Map inside the Surfaces dialog. 
Electrostatic potential maps for all four acids will be displayed. 
Examine the potential in the vicinity of the acidic hydrogen 
(one of the two equivalent acidic hydrogens for sulfuric acid). 
Change the scale (color) to highlight differences in this region. 
Select Properties (Display menu) and click on one of the maps. 
Type 0 and 300 inside the boxes underneath Property Range 
in the Surface Properties dialog. Press the Enter key (return 
key for Mac) following each data entry. Regions on the map that 
are colored blue correspond to acidic sites, the more blue the 
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greater the acidity. On this basis, rank the acid strength of the 
four compounds.

5.	 Remove acids and any open dialogs from the screen.

6.	 One after another, build trichloroacetic, dichloroacetic, 
chloroacetic, formic, benzoic, acetic and pivalic acids. Put all into 
the same document (New Molecule instead of New following 
the first molecule). Click on  when you are finished.

acid	 pKa	 acid	 pKa

trichloroacetic (Cl3CCO2H)	 0.7	 benzoic (C6H5CO2H)	 4.19
dichloroacetic (Cl2CHCO2H)	 1.48	 acetic (CH3CO2H)	 4.75
chloroacetic (ClCH2CO2H)	 2.85	 pivalic ((CH3)3CCO2H)	 5.03
formic (HCO2H)	 3.75

7.	 Note that the name of the presently selected molecule in the 
document appears at the bottom of the screen. This indicates 
that a calculated structure is available in Spartan Student’s 
database. Click on  to the left of the name and then click 
on Replace All in the dialog which results. Structures obtained 
from EDF2/6-31G* calculations (the same model used earlier 
in this tutorial) will replace those you have built.

8.	 Select Surfaces from the Setup menu. Click on Add at the 
bottom of the Surfaces dialog and select Electrostatic Potential 
Map from the resulting menu. The graphic calculation will 
proceed without further intervention, but may require a few tens 
of seconds to complete. Leave the Surfaces dialog on screen. 

9.	 Bring up the spreadsheet. Expand it so that you can see all seven 
molecules. First, left click to select, then right click inside the 
header cell of the leftmost column and select Rename Selected 
using SSPD from the menu. The name of each molecule will 
appear. Next, double click inside the header cell of an available 
data column, type pKa and press the Enter key (return key 
for Mac). Enter the experimental pKa’s. Press the Enter key 
(return key for Mac) following each entry.
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10.	 Arrange the molecules on screen such that the acidic hydrogen 
is visible. To display them all at once you need to check the 
box to the left of the Label column in the spreadsheet for each 
entry. To move the molecules independently, you need to select 
(uncheck) Coupled from the Model menu.

11.	 Click on Electrostatic Potential Map inside the Surfaces dialog 
to turn on the electrostatic potential map for each molecule. 

	

12.	 Bring up the Surface Properties dialog; select Properties from 
the Display menu and click on one of the electrostatic potential 
maps. Click on the  button next to Max. under the property 
range to post the maximum value for electrostatic potential in 
each molecule into the spreadsheet. Double click the resulting 
header cell in the spreadsheet and replace the contents with the 
word potential.

13.	 Select Plots from the Display menu, then click on Add.
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	 Select pKa under the X Axis menu and potential from the Y 
Axes list, and click on Add. The data points are connected by a 
smooth curve. 

	
	 Click on Edit at the top of the plot and select Least Squares 

from the choices to the right of Curve and click Done. Does the 
property of maximum electrostatic potential appear to correlate 
with pKa?

	
14.		 Close carboxylic acids and any dialogs from the screen.
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9
Internal Rotation in n-Butane

This tutorial illustrates the steps required to calculate the energy of 
a molecule as a function of the torsion angle about one of its bonds, 
and to produce a conformational energy diagram.

Rotation by 1800 about the central carbon-carbon bond in n-butane 
gives rise to distinct anti and gauche staggered structures. Both 
of these should be energy minima (conformers), and the correct 
description of the properties of n-butane is in terms of a Boltzmann 
average of the properties of both conformers.

gaucheanti

CH3

H H
CH3

HH
H

H CH3

CH3

HH

This tutorial shows you how to calculate the change in energy as 
a function of the torsion angle in n-butane, place your data in a 
spreadsheet and make a conformational energy diagram.

1.	 Click on  to bring up the organic model kit. Build and 
minimize. Click on  to dismiss the model kit.

2.	 Set the CCCC dihedral angle to 00 (syn conformer). Click on 
. Click on the four carbon atoms in sequence. Type 0 (00) 

into the box to the right of dihedral... at the bottom right of the 
screen and press the Enter key (return key on Mac).

3.	 Select Constrain Dihedral from the Geometry menu (or click 
on the  icon at the top of the screen). Select the CCCC torsion, 
and then click on  at the bottom right of the screen. The icon 
will change to  indicating that a dihedral constraint is to be 
applied. 
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	 Check the box to the left of Profile at the bottom right of the 
screen. This will result in three additional text boxes.

	
	 Leave 0 (0°) in the leftmost box, but change the contents of the 

middle box from 0 to 180 (180°). You need to press the Enter 
(return) key after you type in the value. Steps should be 10. If 
it is not, type 10 and press the Enter (return) key. What you 
have specified is that the dihedral angle will be constrained first 
to 0°, then to 20°*, etc. and finally to 180°. Click on . 

4.	 Bring up the Calculations dialog (Setup menu) and select 
Energy Profile from the first menu to the right of Calculate, 
and Semi-Empirical from the second menu. Click on Submit 
and accept the name n-butane. A set of 10 PM3 semi-empirical 
calculations will be performed.

5.	 When the calculations on all conformers have completed, 
they will generate a new document named n-butane.prof.
M0001. Choose Yes when prompted to open the new file. (You 
might wish to close n-butane to avoid confusion.) Align the 
conformers to get a clearer view of the rotation. Select Align 
from the Geometry menu and, one after the other, click on 
either the first three carbons or the last three carbons. Then 
click on the Align button at the bottom right of the screen, 
and finally click on . Bring up the spreadsheet (Display 
menu), and enter both the energies relative to the 180° or anti 
conformer, and the CCCC dihedral angles. First, click on the 
label (“M0010”) for the bottom entry in the spreadsheet (this 
should be the anti conformer), then click on the header cell 
for the left most blank column, and finally, click on Add... at 
the bottom of the spreadsheet. Select rel. E from among the 
selections in the dialog which results, kJ/mol from the Energy 
menu and click on OK. To enter the dihedral angle constraints, 
select Constrain Dihedral from the Geometry menu, click 
on the constraint marker and click on  at the bottom of the 

*	 The difference between constraint values is given by: (final-initial)/(steps-1).
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screen (to the right of the value of the dihedral angle constraint). 
Finally, click on .

6.	 Select Plots... (Display menu), then click on Add. Select 
Constraint (Con1) from the items in the X Axis menu and rel. 
E(kJ/mol) from the Y Axes list. Click on Add to display a plot 
which, as expected, contains two energy minima (corresponding 
to the gauche and anti conformers).

	
7.	 Close all files and dialogs.
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10
Ethinamate

O
O

NH2

Acrylonitrile, cyclohexanone and camphor are examples of molecules 
that adopt only a single conformation. Most molecules can adopt 
more than one conformation, due to rotation about single bonds 
or puckering of rings. The sedative ethinamate offers both rotation 
about the ring oxygen bond and the possibility for the carbamate 
functionality to occupy either the equatorial or axial position on the 
ring. This tutorial uses ethinamate to illustrate the procedure needed 
to find the lowest-energy conformer (global minimum).

1.	 Bring up the organic model kit ( ). Click on Rings, select 
Cyclohexane from the menu and click anywhere on screen. 
Click on sp3 oxygen ( ) in the model kit and add to either 
an equatorial or axial free valence on cyclohexane. Click on 
Groups and select Amide from the menu. Make certain that free 
valence on the amide group to be used for bonding is associated 
with carbon and not with nitrogen. This is indicated by a • on 
the icon at the top of the model kit.

	
C N
O

•

	 You can move the bonding position by repeatedly clicking on the 
icon. When you are satisfied, add the amide to oxygen to make 
the carbamate functionality. Finally, select Alkynyl from the 
Groups menu and add to the same carbon on the cyclohexane 
ring as occupied by the carbamate group (using the remaining 
axial or equatorial free valence). Click on  and then on . 



54	 Tutorial 10

2.	 Bring up the Calculations dialog (Setup menu). Select 
Equilibrium Conformer from the leftmost menu to the right 
of Calculate. The only model allowed in Spartan Student for 
this task is molecular mechanics (the MMFF model) and this 
will be selected. All possible conformers will be examined* but 
only the most stable (according to the MMFF model) will be 
returned. Click on Submit at the bottom of the dialog. Accept 
the name ethinamate. 

3.	 Which group, alkynyl or carbamate, occupies the equatorial 
position?

4.	 The name ethinamate appears at the bottom right of the screen. 
This indicates that the molecule exists in the subset of the Spartan 
Spectra and Properties Database (SSPD) included with Spartan 
Student. Click on  immediately to the left of the name, click 
on Replace. The entry in SSPD will replace your model. Is the 
conformation of ethanimate in the database the same as you have 
calculated?

5.	 Close ethinamate as well as any open dialogs.

*	 This system is small, and the possible conformers will be systematically examined. This 
is not practical for molecules with a large number of degrees of conformational freedom. 
Here, Spartan Student employs Monte-Carlo methods.
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11
Ene Reaction

This tutorial illustrates the steps involved in first obtaining an initial 
guess for, and then obtaining a transition state for a simple chemical 
reaction. Following this, it demonstrates how to produce a reaction 
energy diagram.

The ene reaction involves transfer of an allylic hydrogen to a double 
bond. A new carbon-carbon bond is formed, for example, reaction of 
propene and ethylene leading to 1-pentene.

H
1

2
3

5

4

H

The ene reaction belongs to the class of so-called pericyclic reactions 
which also includes such important processes as the Diels-Alder 
reaction and the Cope and Claisen rearrangements.

In this tutorial, you will locate the transition-state for the ene reaction 
of ethylene and propene and show the detailed motions which the 
atoms undergo during the course of reaction. It is easier to start from 
1-pentene (the product), rather than from the reactants.

1.	 Bring up the organic model kit and build 1-pentene in a 
conformation in which one of the terminal hydrogens on the 
ethyl group is poised to transfer to the terminal methylene 
group. Click on .

2.	 Select Guess Transition States from the Build menu (or click 
on the  icon at the top of the screen). Click on bond a and 
then click on bond b (see figure below). A curved arrow from 
bond a to bond b will be drawn.



56	 Tutorial 11

	

C

C
C

C

C

HH
H

H H

HHHH H

a

bc

d

e

	 Next, click on bond c and then on bond d. A second curved 
arrow from bonds c to d will be drawn. Finally, click on bond 
e and, while holding down the Shift key, click on the (methyl) 
hydrogen to be transferred and on the terminal (methylene) 
carbon to receive this hydrogen. A third curved arrow from bond 
e to the center of a dotted line that has been drawn between the 
hydrogen and oxygen will appear (see below left). If you make 
a mistake, you can remove an arrow by selecting Delete from 
the Build menu (click on ) and then clicking on the arrow. 
(You will need to select  to continue.) Alternatively, hold 
down the Delete key as you click on an arrow. With all three 
arrows in place, click on  at the bottom right of the screen. 
Your structure will be replaced by a guess at the ene transition 
state (see below right). If the resulting structure is unreasonable, 
then you have probably made an error in the placement of the 
arrows. In this case, select Undo from the Edit menu to return 
to the model with the arrows and modify accordingly.

	
3.	 Enter the Calculations dialog (Setup menu), and specify 

calculation of transition-state geometry using the 3-21G 
Hartree-Fock model. Select Transition State Geometry from 
the leftmost menu to the right of Calculate, and choose Hartree-
Fock and 3-21G from the two rightmost menus. Finally, check 
IR under Calculate. This will allow you to confirm that you 
have found a transition state, and that it smoothly connects the 
reactant and the product. Click on Submit. Save the file as ene 
reaction 1-pentene.
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4.	 When the job completes, animate the motion of atoms along 
the reaction coordinate. Select Spectra from the Display menu 
and click on the IR tab. Click on the top entry in the list in the 
IR dialog that results. It corresponds to an imaginary frequency, 
and will be designated with an i in front of the number. 

A vibrational frequency is proportional to the square root of a 
quantity that reflects the curvature of the potential surface along a 
particular (normal) coordinate corrected for the masses of atoms 
involved in motion along that coordinate. At a transition state (the 
top of a hill), the curvature is negative (it points down). Since 
mass is positive, the quantity inside the square root is negative and 
the frequency is an imaginary number.

	 Is the vibrational motion consistent with an ene reaction of 
interest and not with some other process? 

5.	 Controls at the bottom of the IR dialog allow for changing both 
the amplitude of vibration (Amp) and the number of steps that 
make up the motion (Steps). The latter serves as a speed control. 
Change the amplitude to 0.3. Type 0.3 in the box to the right of 
Amp and press the Enter key (return key on Mac). Click on 
Make List at the bottom of the dialog. This will give rise to a 
group of structures that follow the reaction coordinate from the 
transition state toward both reactant and product. Remove the 
original transition state: click on ene reaction 1-pentene (the 
vibrating molecule) and close it, along with the IR dialog.

6.	 Enter the Calculations dialog and specify calculation of Energy 
using the Hartree-Fock 3-21G model. Make certain that 
Global Calculations is checked, and click OK. Next, enter the 
Surfaces dialog and specify evaluation of a density surface and 
an electrostatic potential map. Click on Add and select More 
Surfaces... from the menu. The Add Surfaces dialog will appear.

	 Select density (bond) from the Surface menu and none from 
the Property menu. Remove the checkmark from Fixed. Click 
on OK. Repeat the process, this time selecting density (bond) 
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from the Surface menu and potential from the Property menu. 
Click on OK.

7.	 Submit for calculation. Name it ene reaction 1-pentene  
sequence. Once the job has completed, enter the Surfaces dialog 
and examine the surfaces that you have calculated (click on 
Density to turn it on). Repeat this procedure for the electrostatic 
potential map. (Click on Density to turn it off and Electrostatic 
Potential Map to turn it on.) For each, step through the sequence 
of structures (  and ) keys at the bottom of the screen) or 
animate the reaction ( ). Note, in particular, the changes in 
bonding revealed by the bond density surface. Also pay attention 
to the value of the potential on the migrating atom. This reflects 
its charge. Is it best described as a proton (blue), hydrogen atom 
(green) or hydride anion (red)? 

8.	 Close ene reaction 1-pentene sequence and any open dialogs.

9.	 Remove any molecules and dialogs from the screen.
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12
SN2 Reaction of Fluoride  

and Methyl Chloride
This tutorial illustrates construction of an energy profile for a 
simple SN2 reaction. This starts from the reactants, passes through 
the transition state and ends up with the products.

The SN2 reaction passes through a transition state in which carbon is 
in a trigonal bipyramid geometry and the entering and leaving groups 
are colinear.

F–  + C Cl

H

H

H
+  Cl–CF

H

H

H
C

H

H H

ClF

1.	 First, construct methyl chloride. Then select fluorine from the 
palette of icons in the model kit, click on the Insert button at the 
bottom right of the screen or hold down the Insert key (option 
key on Mac) and click anywhere on screen. Alternatively, 
double click in a blank area of the screen following selection 
of fluorine. Two detached fragments, methyl chloride and 
hydrogen fluoride, appear on screen. Click on  and then click 
on the free valence on fluorine. Click on . Alternatively, hold 
down the Delete key and click on the free valence on fluorine. 
You are left with methyl chloride and fluorine atom (fluoride). 
Manipulate the two such that fluoride is poised to attack methyl 
chloride from the backside (as in the transition state above). 
(Recall that translations and rotations normally refer to both 
fragments, but can be made to refer to a single fragment by first 
clicking on the fragment and then holding down on the Ctrl 
key while carrying out the manipulations.)

2.	 Select Constrain Distance from the Geometry menu (or click 
on the  icon at the top of the screen). Click on F, then on C 
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and finally click on  at the bottom right of the screen. The 
icon will change to  indicating a constraint is to be applied 
to this distance. Type 3.0 (3.0Å) into the box to the right of the 
icon and press the Enter key (return on Mac). Click on . 
You should get a structure with three-fold symmetry with a CF 
bond length of 3.0Å.

3.	 Again select Constrain Distance. Click on the constraint 
marker between C and F (or click on the two atoms in turn).
Check the box to the left of Profile at the bottom right of the 
screen. This will result in two additional text boxes.

	
	 Leave the value 3.000 (3.0Å) in the leftmost box alone, but 

change the contents of the middle box from 0 to 1.4 (1.4Å). You 
need to press the Enter (return) key after you type in the value. 
Set Steps to 17 (type 17 in the box to the right of Steps and press 
the Enter (return) key). What you have specified is that the CF 
distance will be constrained first to 3.0Å, then to 2.9Å*, etc. and 
finally to 1.4Å. Click on .

4.	 Enter the Calculations dialog, and select Energy Profile, 
Hartree-Fock and 6-31G* from the menus to the right of 
Calculate. You need to change Total Charge to Anion.

5.	 Submit the job. Name it fluoride+methyl chloride. When 
completed, it will give rise to a sequence of calculations placed 
in fluoride+methyl chloride.Prof.M0001. You will be prompted 
as to whether you want to open this file. Click on Yes.

6.	 Bring up the Spreadsheet (Spreadsheet from the Display 
menu). Enter (the constrained) CF distances and chlorine 
charges in the spreadsheet. Select Constrain Distance from the 
Geometry menu, click on the constraint marker and click on 

 at the bottom right of the screen. Click on . Bring up the 
Properties dialog. Click on chlorine and click on  to the left 
of Electrostatic under Charges in the Properties dialog. Select 

*	 The difference between constraint values is given by: (final-initial)/(steps-1).
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the structure with the shortest CF distance, click on Add... at the 
bottom of the spreadsheet and select rel E from the menu.

	 Bring up the Plots dialog, click on Add, and select Constraint 
(Con1) (the distance at which the CF bond has been constrained) 
from the X Axis menu, and both rel E (kJ/mol) and Electrostatic 
(Cl1) from the Y Axes list. Click on Add. One plot gives the energy 
as the reaction proceeds and the other gives charge on chlorine.

	  
7.	 SN2 reactions involving charged species normally need to be 

carried out in highly-polar media, for example, water. Add 
aqueous phase data (based on the empirical SM5.4 model) to 
the spreadsheet. Click on an empty column header, click on 
Add..., select rel Eaq from the list of available quantities, and 
click on OK. Bring up the Plots dialog, click on Add, and select 
Constraint (Con1) from the X Axis and both relE(kJ/mol) and 
rel Eaq(kJ/mol) from the Y Axes list. Click on Add.
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8 to 10 optional

8.	 Enter the Surfaces dialog. Click on Add and select density 
(bond) from the Surface menu and none from the Property 
menu. Remove the checkmark from Fixed. Click on OK. Repeat 
the process, this time selecting density (bond) from the Surface 
menu and potential from the Property menu. Click on OK.

9.	 You don’t need to submit the job, but the graphics calculations 
for all 17 molecules will take 10-20 seconds to complete. When 
they are done, select density inside the Surfaces dialog and click 
on  at the bottom left of the screen to animate the display. Note, 
that bonds are smoothly broken and formed during the course 
of reaction. Click on  to stop the animation.

10.	 Reenter the Surfaces dialog. Turn off display of the density and 
turn on display of the electrostatic potential map. Click on . 
Relate the migration of negative charge during reaction to the 
plot of the charge or bromine. Recall that colors near red indicate 
maximum negative potential.

11.	 Remove all molecules and any dialogs from the screen.
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13
Polypeptides and 
Polynucleotides

This tutorial illustrates use of the peptide and nucleotide model kits. 
It shows how hydrogen bonds influence both the secondary structure 
of polypeptides (proteins) and the double helix of DNA. No quantum 
chemical calculations are performed.

Proteins perform a variety of vital roles in all living organisms: reaction 
catalysis, transport and storage, structural support, immune protection, 
and mediation of nerve impulses, to name a few. Despite the variety, 
all proteins consist of the same basic building blocks (a set of 20 amino 
acids), and are dominated by two main structural motifs (the a helix 
and the b pleated sheet).

a Helix

1.	 Select New from the File menu and click on the Peptide builder 
from the Model Kit. This contains a library of the 20 natural 
amino acids, each identified by a 3-letter code.
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2.	 Click on gly- (glycine). As you toggle the checkbox to the left 
of Sequence on and off, the display window at the top of the 
model kit will shift between a text field showing gly (Sequence 
button checked) and a 2D rendering of non-terminated glycine 
(Sequence button un-checked).

3.	 Make sure the Sequence box is checked, and randomly select 
an additional 9 amino acid residues. Below the pallet of amino 
acids are a series of buttons: a Helix, b Sheet and Other. These 
allow specification of the secondary structure of constructed 
polypeptide sequences.  Select a Helix and click on screen.

4.	 A ball-and-spoke model of a 10-residue polypeptide is displayed. 
There are two open valences (indicated by their yellow color) 
at either end of this non-terminated polypeptide molecule.  
From the lower right side of the Peptide builder, click on the 
Terminate button. The dialog that results lets you terminate the 
polypeptide either as an uncharged form (CO2H and NH2) or as 
a zwitterionic form (CO2

–  and NH3
+).
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	 Choose CO2H  and NH2 (the uncharged form) and click on the 

OK button to terminate.

5.	 To simplify the model, display the molecule as a Tube model and 
deselect Hydrogens from the Model menu. Select Hydrogen 
Bonds from the Model menu. Dotted lines depicting hydrogen 
bonds will appear on screen between the oxygens of carbonyl 
groups and the nitrogens of amine groups (recall that display 
of hydrogens has been turned off). In the a helix structure, 
hydrogen bonds are formed between the C=O of one amino 
acid and NH group of another amino acid, separated by a space 
of 4 residues. It is this network of internal hydrogen bonding 
that holds together the a helix.	
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6.	 To better see the a helix, select Ribbons from the Model menu. 
You may also, if you choose, turn off the molecular structure 
display of the peptide all together, by selecting Hide from the 
Model menu. Rotate the model on screen to get an idea of its 3D 
structure. Note that the hydrogen bonds are still visible. Close 
the document when you finish examining the a helix structure.

b Pleated Sheet

7.	 Select New from the File menu and click on the Peptide builder 
from the Model Kit. The ten-residue sequence you previously 
constructed will remain in the viewer window at the top of the 
builder (if not, make sure the Sequence box is checked and 
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randomly choose another 10 amino acids). Select b Sheet and 
click on screen.

8.	 Again, a model of a 10-residue polypeptide is displayed. This 
time, the secondary structure is in the b sheet configuration. 
Terminate the structure in either the uncharged or zwitterionic 
form.

9.	 Click on  to remove the model kit. Note that the same 
10-residue sequence is significantly longer in the b sheet 
arrangement. As you did for the a helix, switch to a tube model, 
turn hydrogens off and turn on display of hydrogen bonds. The 
extended b sheet does not contain internal hydrogen bonding 
so no hydrogen bonds appear. Close the document when you 
finish examining the b-sheet structure.

10.	 Hydrogen bonds play a role in connecting b strands to make 
a b sheet. Select Access PDB from the File menu and specify 
1JIC*. Turn on hydrogen bonds (Model menu). Hydrogen 
bonds appear between different b strands. Note that hydrogen 
bonds may also exist between residues on the same strand, in 
this example they form a hairpin turn resulting the same b sheet 
running adjacent to itself but in the opposite (or anti-parallel) 
direction. Close 1JIC when you have finished examining the 
b-sheet structure.

B-DNA

11.	 Select New from the File menu and click on the Nucleotide 
model kit.

*	 PDB designation 1JIC. Torres, A.M., Kini, R.M., Selvanayagam, N., Kuchel, P.W.; J. 
Biochem. 360: 539-548 (2001). 
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	 This model kit includes options for building a variety of nucleic 
acid sequences (based on nucleotide residues) included both 
single and double stranded DNA and RNA, as well as hybrid 
DNA-RNA sequences. Choose DNA from the menu in the 
middle of the Nucleotide model kit.

12.	 Just below the viewer window (inside the model kit) are four 
buttons designating the nucleotide bases. Click on A (adenine). 
Toggle the check-box to the left of Sequence on and off. The 
display window at the top of the model kit will shift between 
a text field showing A- (with the Sequence button checked) 
and a 2D rendering of adenine (with the Sequence button un-
checked). Note that even though the 2D rendering displays 
only the nucleotide base, when building, the entire nucleotide, 
include the organic base (purine or pyrimidine), sugar (ribose), 
and phosphate group, will be inserted on screen.  In the case of 
double-stranded sequences, the complementary base will also 
be inserted.

13.	 Click on screen to insert an adenosine nucleotide, and its 
complementary base thymine nucleotide. Select Hydrogen 
Bonds from the Model menu to display hydrogen bonding 
between the AT base pair. Note that adenosine-thymine pairings 
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in double stranded DNA will always form two hydrogen bonds, 
where as guanine-cytosine pairings result in the formation of 
three hydrogen bonds. When you are finished examining the 
A-T base pair, select Clear from the Edit menu.

14.	 Make sure the Sequence box is checked, and randomly select 
an additional 15-20 nucleotide bases. Below the pallet of 
nucleotide bases  is a series of buttons (marked A, B, and Other) 
that provide for specification of the nucleotide sequence Helix. 
Select B for the helix type and click on screen. (DNA exists in 
three forms, A, B, and Z. Almost all DNA in living organisms 
is in the B-DNA configuration.)

15.	 Select Tube and Ribbon from the Model menu. Display of 
hydrogen bonds has already been specified. If you turned this 
off, hydrogen bonds can be accessed from the Model menu. 
Also select Configure from the Model menu and click on the 
Ribbons tab. Select By Strand from the Coloring options and 
click OK. The ribbon tracing the backbone of the sequence you 
constructed from the builder is colored red; the complementary 
sequence is colored blue.

16.	 Because the glycosidic bonds of the base pairs (bonds connecting 
the base pairs to their sugar molecules) are not exactly opposite 
one another, B-DNA has two clearly visible grooves (called the 
major groove and the minor groove). The major groove is ~ 12 
Å wide and the minor groove is roughly half that size.  Select 
Space-Filling from the Model menu and locate the major and 
minor grooves in your B-DNA sequence.

17.	 Close all open documents.
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14
Biomolecules

This tutorial illustrates models appropriate to large biomolecules 
(proteins and nucleotides), in particular, ribbon displays of 
secondary structure and display of hydrogen bonds. No calculations 
are performed.

Treatment of very large molecules, proteins and nucleotides 
(biopolymers) most important among them, requires models which 
are simpler than those appropriate for small organic and inorganic 
molecules. This refers both to structural models for display and 
manipulation (where a simplified ribbon display of the biomolecule’s 
backbone is used) and to theoretical models used for calculation of 
structure and properties (where molecular mechanics replaces quantum 
chemical models).

This tutorial uses an enzyme (phospholipase A2) extracted from the 
venom of the common cobra (Naja naja) to illustrate a variety of 
models for the display of biomolecules, including ribbon displays to 
elucidate the backbone and hydrogen-bond displays to disclose some 
of the forces holding the structure together.

1.	 From the File menu, click on Access PDB... then type 1A3F* in 
the PDB Id code: field and click on Open**.

	
	 Note that a simple ribbon display, demarking the protein 

*	 PDB designation 1A3F. Segelke, B.W., Nguyen, D., Chee, R., Xuong, N.H., Dennis, E.A.; 
J.Mol. Bio., 279, 223-232 (1998).

**	 If you do not have an internet connection, the file 1A3F is available from the tutorials 
directory.
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backbone (secondary structure) has replaced the usual structural 
models (ball-and-spoke, tube, etc.). 

	
	 To see why this is preferable, turn on (select) one of these models 

from the Model menu. The model styles that provide detail of 
the enzyme’s primary structure have completely obliterated 
a significant structural detail (namely that this enzyme is 
comprised of three identical sub-units). Note, however, that a 
space-filling model (Space-Filling from the Model menu) does 
provide indication of the overall size and shape of the enzyme.

2.	 To better visualize the three sub-units, turn the selected model 
style off (choose Hide from the Model menu) and select 
Configure from the Model menu, click on the Ribbons tab, 
and finally select By Strand. Note that each oligomer is 
colored differently.  Explore the remaining options for coloring 
(click Apply after each selection). Monochrome provides a 
single colored model useful for tracing the backbone of the 
biomolecule. By Secondary Structure gives information about 
how the backbone is organized (alpha-helices are colored red, 
beta-sheets are colored blue, while any remaining segments are 
colored green). By Residue provides a multi-colored display 
where each unique color represents a specific amino acid residue 
type.  To further explore, click on the OK button to dismiss the 
Configure dialogue, and then click on the individual colored 
segments of the ribbon. The specific peptide or amino acid 
residue (in the case of peptide chains, proteins, or enzymes) 
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or nucleotide base (in the case of nucleotide chains, DNA, or 
RNA) will be specified in the lower right of the workspace.

	 Hydrogen bonding is known to be a decisive factor in determining 
the three-dimensional structures of biopolymers. The base 
pairs in complementary strands which make up DNA are held 
together by hydrogen bonds. Helical structures in proteins are 
also maintained by hydrogen bonds as are neighboring strands 
in so-called b sheets.

3.	 Select Ramachandran Plot from the Geometry menu.

	

	 Each point gives the dihedral angles between a pair of amino 
acids (the so-called f and y angles). Note that many points fall 
into two clusters, one corresponding to helices and the other to 
b sheets.

4.	 Close 1A3F.
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15
Isomeric C5H8 Dienes

In addition to 2-methyl-1,3-butadiene, cis and trans-1,3-pentadiene 
(conjugated dienes) and 1,4-pentadiene (a non-conjugated 
diene), there are three other C5H8 dienes: 3-methyl-1,2-butadiene 
(1,1-dimethylallene) 1,2-pentadiene (ethyl allene) and 2,3-pentadiene 
(1,3-dimethylallene). 

1.	 Build all seven C5H8 dienes (place in a single document) and 
bring up the spreadsheet (Spreadsheet from the Display menu). 
With any of the dienes selected, click on the Replace All button in 
the Preview dialog (brought up by clicking on  to the left of the 
molecule name at the bottom of the screen). This will substitute 
entries in SSPD for all seven C5H8 dienes. To enter names into 
the spreadsheet, click on the top left header cell (Label), hold 
down the right mouse button and select Rename Selected Using 
SSPD  from the menu. Bring up Molecule Properties dialog 
(Display menu) and click on the  button to the left of Heat. 
This enters the T1 heat of formation (the experimental heat of 
formation is given in parenthesis where available from the NIST 
database).

2.	 Using the spreadsheet and the molecular properties dialog, 
verify that the T1 model correctly reproduces the ordering 
of experimental heats. Then use the T1 heats to answer the 
following questions:

	 What is the difference in stability (heat) between the best of 
the three conjugated dienes and 1,4-pentadiene? What is the 
approximate energy gain due to conjugation? What is the 
difference in stabilities between the best of the substituted allenes 
and the best of the conjugated dienes?

3.	 Close any molecules and dialogs that are open on screen.
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16
Infrared Spectra  

of Short-Lived Molecules
While infrared spectroscopy is by no means as formidable a tool 
as NMR for elucidating the structures of molecules, it does offer 
significant advantages that make it the method of choice in some 
instances. It is more sensitive, meaning that it can be used to detect 
transient species, for example, molecules trapped in an inert matrix at 
very low temperature. On the practical side, an infrared spectrometer 
is inherently simpler (more robust) and can be put into a much 
smaller package than an NMR spectrometer. This means that the 
spectrometer can be brought to the sample rather than the other way 
around. Imagine, putting an NMR spectrometer on the Mars rover! 
The problem is that IR spectroscopy unlike NMR typically does 
not provide an unambiguous structure. However, a close match to a 
calculated spectrum may offer convincing evidence for the veracity 
of a particular structure (or a mismatch convincing evidence that a 
structure is incorrect). 

The infrared spectrum of an unknown C4H4 isomer shows  
noticeable absorptions at 854, 1608, 2994 and 3080 cm-1. Possible 
structures include but-1-yne-3-ene, butatriene, singlet-1,3-butadiene, 
methylenecyclopropene and tetrahedrane.

HH

H

H

H

H

H

H

but-1-yne-3-ene butatriene cyclobutadiene

H H

HH

HH

H H
methylenecyclopropene

H

H

HH
tetrahedrane

1.	 Build all five molecules and put into a single document (start 
with New Molecule and not New following the first molecule). 
Replace your structures with those from the database. Click on 
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 to the right of the molecule name at the bottom of the screen 
to bring up the Preview dialog and click on Replace All.

2.	 Give proper names to the compounds. Open the spreadsheet 
(Spreadsheet under the Display menu), click on Label (the 
leftmost header cell), then right click and select Rename 
Selected Using SSPD from the menu that appears.

3.	 Select Spectra from the Display menu and click on the IR 
tab at the top of the resulting dialog. Numerical values of the 
frequencies and infrared intensities of the selected molecule in 
the document will appear at the left of the dialog. Note that 
the frequencies have been scaled to take account of systematic 
errors in the calculations. To see unscaled frequencies,  move 
the slider bar to the right of Scale: from 0.962 (the default) to 
1.000. To return to scaled frequencies, click on the Standard 
button.  Display the infrared spectrum of the selected isomer. 
Click on Draw Calculated at the right of the dialog. Move 
through the list to bring up the spectra for the other isomers.

	 The calculated infrared spectrum of which C4H4 isomer best fits 
the unknown infrared spectrum?

4.	 Close any molecules and dialogs that are open on screen.
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17
Using 13C NMR Spectra to 

Distinguish Structural Isomers
NMR spectroscopy, in particular 13C NMR spectroscopy, is arguably 
the single most important tool available to an organic chemist 
to establish molecular structure. Obtaining an NMR spectrum is 
straightforward and the spectrum itself is very simple, comprising 
but a single line for each unique carbon in the molecule. Because a 
mass spectrum is normally also available, the molecular formula will 
be known, and assignment of the NMR reduces to deciding among 
possible isomers. Chemical evidence (how the molecule was made) 
can usually be counted on to eliminate some choices and to strengthen 
the case for others. Still, pinning an NMR spectrum to a particular 
molecule can be difficult and fraught with error.  

NMR assignment problems can be reduced but not alltogether 
eliminated by requiring that both proton and 13C NMR spectra 
are consistent with a particular structure. This is routine practice. 
In principal, all ambiguity can be eliminated by cross-correlating 
the results of the 13C NMR with those of proton NMR using a 
variety of so-called 2D spectra. However, 2D NMR experiments 
are not yet the norm, if for no other reason because they require 
significant instrument time on a spectrometer that may cost upward 
of $1,000,000. 

The fact that NMR spectra for reasonable size organic molecules 
may now be routinely calculated in a few minutes to a few hours 
on a personal computer costing $1000 or less raises the possibility 
for another tool to assist with spectral assignments. Whether this 
possibility becomes a reality ultimately depends on the ability of the 
calculations to obtain NMR spectra that are sufficiently accurate to 
distinguish among the different isomers. 
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In this tutorial we see which of three structural isomers with molecular 
formula C17H19NO3 (morphine, norcodeine and hydromorphone) best 
fit the NMR spectrum of an unknown isomer, or if clear assignment 
is not possible.

1.	 Build morphine, norcodeine and hydromorphone and put in the 
same document. (If the name for each fails to appear at the 
bottom of the screen, then you have made a mistake.)
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HO

NMe
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HO
morphine

O

MeO
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HO
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O
hydromorphone

	 Click on the Replace All button at the bottom of the Preview 
dialog. This will substitute structures from SSPD for what you 
have built. To name the three isomers, bring up a spreadsheet 
(Spreadsheet under the Display menu), click on Label (the 
leftmost header cell), then right click and choose Rename 
Selected Using SSPD from the menu.

2.	 Bring up the 13C NMR Spectra dialog (Spectra under the 
Display menu) and click on the 13C NMR tab. Click on Draw 
Calculated in the section designated 13C Spectra. Next, 
check Local File in the section designated Experimental 
Data From, click on Draw Experimental, move to the using 
SSPD subdirectory under the tutorials directory and click on 
unknown C17H19NO3 carbon NMR. You will need to repeat 
this two more times (providing the same experimental spectrum 
for each of the three candidates). Calculated and experimental 
13C spectra now appear on the same plot. Step through the three 
isomers. Which, if any, of the calculated 13C spectra bests fits 
the experimental spectrum? To associate lines with specific 
carbons in each of the calculated spectra, bring up the Atom 
Properties dialog. Select Properties from the Display menu 
and click on an atom. Alternatively, you can attach chemical 
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shifts as labels on your structures. Select Configure from the 
Model menu and click on Chem Shift under Atom in the dialog 
that results. Simplify your models by changing to a tube model 
(Tube under the Model menu) and by removing hydrogens 
from the model (Hydrogens under the Model menu). 

3.	 Close any molecules and dialogs that are open on screen.



78	 Tutorial 18

18
Using 13C NMR Spectra to 
Distinguish Stereoisomers

The combination of 1D and 2D NMR spectra is usually able to 
provide unambiguous assignment of molecular structure, including 
assignment of stereochemistry. However, practical considerations 
(time on an expensive instrument) often make 2D experiments the 
exception rather than the normal. Distinguishing stereoisomers may 
be difficult experimentally, simply because the alternatives are likely 
to be structurally very similar. For the same reason, it is likely to be an 
ideal case for calculations, because comparisons between molecules 
with similar structures should benefit from cancellation of errors. Are 
calculated 13C NMR spectra good enough to be able to clearly be able 
to distinguish between stereoisomers?

The hydroxyl CO bond in tibolone, shown below on the left, is gauche 
to the methyl group at C13 (the alkyne is anti), whereas it is anti (and 
the alkyne is gauche) in the stereoisomer shown on the right. The 
experimental 13C spectrum of a molecule that has been assigned as 
tibolone shows a line at 12.7 ppm attributed to the methyl group 
at C13 and lines at 88.9 and 74.8 ppm attributed to the internal and 
external alkyne carbons, respectively.
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1.	 Build both stereoisomers and replace your structures with those 
in SSPD. (If the name for each fails to appear at the bottom of 
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the screen, then you have made a mistake.) Select Properties 
from the Display menu and for each stereoisomer, record the 
calculated 13C shifts for the methyl group carbon and for the 
two alkyne carbons. Do the calculations support or refute the 
experimental assignment, or are they ambiguous?

2.	 Close any molecules and dialogs that are open on screen.
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19
Electrophilic Reactivity 
of Polycyclic Aromatics

Naphthalene, anthracene and phenanthrene undergo electrophilic 
substitution similar to benzene. Are they likely to be more or less 
reactive? Local ionization potential maps should be able to provide 
an answer. The lower the potential on the aromatic ring, the more 
likely it is to give up an electron, that is, the more susceptible it will 
be to electrophilic attack. 

naphthalene anthracene

phenanthrene

1.	 Build benzene, naphthalene, anthracene and phenanthrene and 
put into a single document. With any of the four molecules 
selected, click on Replace All from the Preview dialog. Give the 
molecules proper names. Bring up a spreadsheet (Spreadsheet 
under the Display menu), click on Label (leftmost header cell), 
then right click on an empty header cell and choose Rename 
Selected Using SSPD from the menu.

2.	 Bring up the Surfaces dialog from the Setup or Display menu 
and make certain that Global Surfaces is checked. Click on 
Add at the bottom of the dialog and select Local Ionization 
Potential Map from the menu. When the graphics calculations 
have completed (a few tens of seconds), bring up the spreadsheet 
(Spreadsheet under the Display menu) and check the box to 
the left of each of the four entries. The four molecules will now 
be simultaneously displayed, but they will be coupled. To move 
them independently, select Coupled from the Geometry menu 
(this will remove the checkmark to the left). Position the four 
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molecules on screen such that the π system is visible, and check 
Local Ionization Potential Map inside the Surfaces dialog. 
Which of the four molecules is indicated by its local ionization 
potential map to be most susceptible to electrophilic attack? 
Which positions on naphthalene, anthracene and phenanthrene 
are most susceptible?

3.	 Compare local ionization potential maps for naphthalene, 
quinoline and isoquinoline. Focusing on the carbon ring, which 
of the three is likely to be most susceptible to electrophilic 
attack? Which is likely to be least susceptible?

	
N

N

quinoline isoquinoline

4.	 Compare the local ionization potential map for naphthalene with 
those of indole, benzofuran and benzothiophene. Focusing on 
the carbon ring, which of the four compounds is most susceptible 
to electrophilic attack? Which is the least susceptible?

	
N
H

O S

indole benzofuran benzothiophene

5.	 Close any molecules and dialogs that are open on screen.




